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System Requirements 

Operating system and virtual environment requirements 
Ipswitch supports WhatsUp Gold operating on the following Windows operating systems: 

 Microsoft Windows 7 Ultimate edition (32-bit and 64-bit)  

 Microsoft Windows Vista Ultimate edition with Service Pack 2 (32-bit and 64-bit) 

 Microsoft Windows Vista Business edition with Service Pack 2 (32-bit and 64-bit) 

Ipswitch supports WhatsUp Gold operating on the following Windows Server platforms: 

 Microsoft Windows Server 2008 R2 

 Microsoft Windows Server 2008 

 Microsoft Windows Server 2003 

WhatsUp Gold will operate on any supported operating system on the following hypervisor 
architectures: 

 VMware ESX versions 3.5, 4.0 

 VMware ESXi versions 3.5, 4.0, and 4.1 

 Microsoft Hyper-V Server 2008 R2 

 Important: If WhatsUp Gold is hosted on VMWare ESX, ESXi or Microsoft Hyper-V Server 
2008, to avoid licensing issues, make sure that you assign a static MAC address to the virtual 
machine that WhatsUp Gold is operating on. 
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Database requirements 
WhatsUp Gold requires a database to maintain data about monitored devices, store system 
configurations, and save user specified customizations. The database may be co-located with 
the WhatsUp Gold installation, or may be hosted on a remote machine. Data services for 
WhatsUp Gold can be provided by the following database servers:   

If you install WhatsUp 
Gold on: You have these database options: 

 

Microsoft SQL 
Server 2005 
Express Edition 
32-bit 
Local/Remote 

Microsoft SQL 
Server 2005  
Standard 
or Enterprise  
32-bit or 64-bit 
Local/Remote  

Microsoft SQL 
Server 2008 or 
2008 R2 
Standard or 
Enterprise   
32-bit or 64-bit 
Local/Remote 

Microsoft SQL 
Server Cluster 
2005, 2008, or 
2008 R2 
Enterprise or 
Datacenter 
32-bit or 64-bit 
Remote only 

Windows 7 Ultimate     

Windows Vista Ultimate 
(SP2 recommended) 

    

Windows Vista Business  
(SP2 recommended) 

    

Windows Server 2003 SP2    * 

Windows Server 2003 R2 
SP2  

   * 

Windows Server 2008 SP2     

Windows Server 2008 R2     

*Windows Enterprise or Datacenter 

 Important: If using Microsoft SQL Server Cluster 2005, 2008, or 2008 R2, WhatsUp Gold must 
be configured to use a remote database. Installing WhatsUp Gold on the same server as the 
database cluster is not supported. 

 Important: WhatsUp Gold does not support non-English versions of Microsoft SQL Server 
2005, Microsoft SQL Server 2008 or 2008 R2, or Microsoft SQL Server Cluster 2005, 2008, or 
2008 R2. 

 Warning: WhatsUp Gold will not function properly if the 'no count' option for the SQL Server 
instance which hosts the WhatsUp Gold database or the replication feature of the SQL Server 
for the WhatsUp Gold database is enabled. 
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Web server requirements 
Web services are required for the web-enabled functionality and reporting provided by 
WhatsUp Gold. These services are provided by one of the following web servers: 

If you install WhatsUp Gold on:    This IIS version will be used: 

  IIS version 7 IIS version 6  

Windows 7 Ultimate   

Windows Vista Ultimate 
(SP2 recommended) 

  

Windows Vista Business  
(SP2 recommended) 

  

Windows Server 2003 SP2   

Windows Server 2003 R2    

Windows Server 2008 SP2   

Windows Server 2008 R2   

The following is a list of the supported web servers and specific requirements for each 
version: 

 Microsoft Internet Information Services (IIS) version 7 (Use with WhatsUp Gold on 
Windows Server 2008 R2, Windows Server 2008, Windows 7, or Windows Vista). 
 WhatsUp Gold requires the following Web Server (IIS) Role Services at a minimum: 

 Web Server 

 ASP 

 Static Content 

 HTTP Redirection 

 Default Document 

 Note: The installation program will automatically install IIS 7 on platforms where it is 
supported, you can then verify that IIS 7 is installed and properly configured from the Turn 
Windows Features on or off dialog. (Control Panel > Programs and Features > Turn 
Windows Features on or off) Verify that Web Server, ASP, Static Content, HTTP 
Redirection, and Default Document Web Server (IIS) Roles Services have been installed and 
are enabled. 

 Microsoft IIS version 6 (Use with WhatsUp Gold on Windows Server 2003). WhatsUp 
Gold requires the following web server extensions: 

 ASP 
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 Note: You must manually install IIS 6, using instructions provided in the Microsoft Windows 
documentation included with your operating system or the Installing and Configuring 
WhatsUp Gold guide. 

Framework and accessibility requirements 
WhatsUp Gold requires the Microsoft .NET Framework and other Microsoft packages in 
support of scripting and software accessibility. The following is a list of the required software 
framework and support packages: 

 Microsoft .NET Framework 4.0, included in installation program 

 Microsoft .NET Framework 3.5 and Microsoft .NET Framework 2.0, required by the 
installation program.  

 Important: Microsoft .NET Framework 3.5 and Microsoft .NET Framework 2.0 must be 
installed prior to running the installation program. 

 Microsoft Windows Scripting Host v5.7 (or later) 

 Microsoft SAPI 5.1 (required for Text-to-Speech actions) 

Web and mobile interface requirements 
The following web clients and mobile device interfaces are supported for use by WhatsUp 
Gold: 

 WhatsUp Gold Web interface: Microsoft Internet Explorer 7.0, Microsoft Internet 
Explorer 8.0, Microsoft Internet Explorer 9.0, Firefox 3.6.x, Firefox 4.0, or Chrome 9.x 

 WhatsUp Gold Mobile interface: Mobile Safari 2.2, Safari, 3.0, and Safari 4.0; Microsoft 
Internet Explorer Mobile 6.1.x, or Opera Mini 4.2 
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WhatsVirtual supported virtual environments 
The WhatsVirtual plug-in supports virtual hosts and virtual machines running on the 
following virtual environments: 

 VMware vCenter Server 4.0 and 4.1 

 VMware ESX versions 3.5 and 4.0 

 VMware ESXi 3.5, 4.0, and 4.1 

Flow Monitor software requirements 
WhatsUp Gold Flow Monitor has the same base system requirements as Ipswitch WhatsUp 
Gold v15. In addition, WhatsUp Gold Flow Monitor requires: 

 Ipswitch WhatsUp Gold v15 Standard Edition, Premium Edition, MSP Edition, or 
Distributed Edition 

 At least one routing device that supports NetFlow versions 1, 5, 7, and 9 
- or - 
At least one routing device that supports sFlow versions 2 and 5 

 Note: WhatsUp Gold Flow Monitor performs well in most installations that use SQL Server 
2005 Express. However, some large data collections, that require 4 GB of data storage or 
more or where data is collected and archived over a long period of time, may require 32-bit 
MS SQL Server 2005 Standard or Enterprise Edition, 32-bit or 64-bit Microsoft SQL Server 
2008 or 2008 R2 Standard or Enterprise Edition, or 32-bit or 64-bit Microsoft SQL Server 
Cluster 2005, 2008, or 2008 R2 (all editions except Microsoft SQL Server Express edition). 
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Hardware requirements and recommendations 
The following hardware requirements provide a minimum baseline for choosing hardware to 
support your WhatsUp Gold installation. 

 Recommended Required 

Processor(s) WhatsUp Gold: Dual-core 
Flow Monitor: Quad-core 

WhatsUp Gold: Single-core 
Flow Monitor: Dual-core 

Processor speed 2 GHz or more 2 GHz 

RAM WhatsUp Gold: 4 GB 
Flow Monitor: +4 GB 

WhatsUp Gold: 2 GB 
Flow Monitor: +2 GB 

Hard drive space for 
application, SQL Server 
Express Edition database 
application, and supporting 
framework 

3 GB 2 GB 

Hard drive space for 
database and database logs 

WhatsUp Gold: 8 GB or more 
Flow Monitor: +16 GB or more 

WhatsUp Gold: 4 GB 
Flow Monitor: +8 GB 

Network interface card 1 Gbps 100 Mbps 

CD-ROM or DVD-ROM Required if installing from CD-
ROM. Not required for download 
installations. 

Required if installing from CD-
ROM. Not required for download 
installations. 

Video display resolution 1280 x 1024 or higher 1024 x 768 

Sound card SAPI-capable sound card required 
for Text-to-Speech actions 

Not required 

Modem and phone line Required for pager, SMS, and 
beeper actions; modem pooling is 
not supported 

Not required 

GSM modem Required for SMS Direct actions Not required 
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Installing WhatsUp Gold using WhatsUp Setup 

 Note: The Release Notes (http://www.whatsupgold.com/WUG15relnotes) contain the most 
up-to-date information about installing WhatsUp Gold. Read the release notes prior to 
installing to be aware of any potential installation issues. 

 Note: If you are installing WhatsUp Gold on a Windows 2003 Server, you must first install IIS 
6.0 on the server prior to running the installation utility. For information on how to install and 
configure IIS, see Installing IIS on Windows Server 2003 (on page 25). 

Before installing WhatsUp Gold 
Installing WhatsUp Gold is a simple straightforward process, however there are several 
decisions that you must make, and options that you should be aware of before you install 
WhatsUp Gold.  

 You can choose to use either the bundled Microsoft SQL Server 2005 Express Edition, 
installed by the WhatsUp Gold installation program, or an existing Microsoft SQL 
Server 2005, Microsoft SQL Server 2008 or 2008 R2, or Microsoft SQL Server Cluster 
2005, 2008, or 2008 R2 to store the data collected by WhatsUp Gold. See Installing 
WhatsUp Gold using advanced options (on page 12) for more information. 

 You can choose to create and use a SQL Server user account other than the 
recommended 'sa' SQL Server account. See Installing WhatsUp Gold (on page 9) for 
more information. 

 Important: If you want to change the SQL Server user account, the account you want to use 
must have the same permissions as the 'sa' account.  The password you create must meet 
any password complexity rules enforced by the local server or domain. 

 You can choose to use port 80 or some other port for the WhatsUp Gold web site that 
is created and runs on the IIS web server. See Installing WhatsUp Gold (on page 9) for 
more information. 

 Note: It is recommended that port 80 be used for the WhatsUp Gold web site. If another port 
number is used, the URL for the WhatsUp Gold web site will require that port number to be 
appended to the hostname or IP address when forming the URL.  For example if you chose 
8888 as the port number instead of 80 your URL for a WhatsUp Gold install on the local host 
would be: localhost/nmconsole:8888 

 Note:If port 80 is used by a current IIS web site, you must either allow WhatsUp Gold to 
disable that web site and take over port 80, or choose another port. 

http://www.whatsupgold.com/WUG15relnotes
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 You can choose to use a non-default database name for the WhatsUp Gold and Flow 
Monitor databases. See Installing WhatsUp Gold using advanced options (on page 12) 
for more information. 

 Note: The default database name for the WhatsUp Gold database is WhatsUp, the default 
name for the Flow Monitor database is Netflow, and the default name for the Flow Monitor 
Archive database is NFArchive. 

 Note: The Netflow Archive database will use the Flow Monitor database name with the 
letters 'Ar' appended to the end. If you have changed the Flow Monitor database name to 
NetFlowDB, the NetFlow Archive database will be NetFlowDBAr.     

 You can choose to create a non-default Windows user account for WhatsUp Gold 
(default: WhatsUpGold_User). See Installing WhatsUp Gold using advanced options (on 
page 12) for more information. 

 You can choose to use Windows Authentication to access an existing remote 
Microsoft SQL Server 2005, Microsoft SQL Server 2008 or 2008 R2, or Microsoft SQL 
Server Cluster 2005, 2008, or 2008 R2. See Using Windows Authentication for remote 
database access for more information.  

 Note: The installation instructions in this document apply only to WhatsUp Gold Standard 
Edition and WhatsUp Gold Premium Edition. For installation instructions for WhatsUp Gold 
Distributed Edition or WhatsUp Gold MSP Edition, see WhatsUp Gold Distributed Edition 
Deployment Guide (http://www.whatsupgold.com/WUG15dsdg) or WhatsUp Gold MSP Edition 
Deployment Guide (http://www.whatsupgold.com/WUG15mspdg). 

 

Running WhatsUp Setup 
The WhatsUp Setup program allows you to license and install all of your WhatsUp software 
using a single interface. After you have selected the products you want to install, the 
WhatsUp Setup program calls each of the individual product installation programs. Once all 
of the installation programs have successfully completed their installations, the WhatsUp 
Setup program closes.  

To run the WhatsUp Setup program: 
1 Log in directly to Microsoft Windows using the Administrator account (if you do not 

have an account called Administrator, use an account that has full administrative 
privileges to the computer). 

 Caution: We do not recommend using Terminal Services or Remote Desktop to install any 
WhatsUp product. 

http://www.whatsupgold.com/WUG15dsdg
http://www.whatsupgold.com/WUG15mspdg
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2 Start the WhatsUp Setup: 

 If you downloaded an electronic version of the WhatsUp Setup, double-click on the 
downloaded file. 

 If you purchased a WhatsUp Setup CD-ROM, insert the CD-ROM into the appropriate 
drive. If it does not run automatically, click Start, select Run, then enter the CD path 
followed by AutoRun.exe (for example, D:\AutoRun.exe). 

The Install Options dialog appears. 
3 Select the products you want to install.  

 Note: The WhatsUp Setup program detects any currently installed Ipswitch WhatsUp 
branded software and determines which installation options are available (New Installation, 
Upgrade, Repair or Un-install). This information is displayed to the right of the product 
name and version. 

4 Click Next. The License Information dialog appears. 
5 Enter your WhatsUp Gold Activation Key or select an alternative activation method.  

 Note: You must enter your Activation Key made up of the Serial Number and the Username 
And Password (UAP) appended to the end of your Serial Number, which combined are a 
total of 23 characters.  

 
Note: If you are installing using the installation application downloaded from the web link 
provided in the purchase confirmation email, the Activation Key box will be pre-populated 
with your Activation Key.  

The following is an example of an activation key, which is made up of the serial number 
and UAP and the to be entered in Activation Key. 

Serial Number (15 
characters) UAP (8 characters) Activation Key (23 characters) 

01MTBDK5TN99NQ1 XKQKC966 01MTBDK5TN99NQ1XKQKC966 

Click Next. The Installation Summary screen appears. 
6 Read the product installation list to ensure that the products and versions you want to 

install are going to be installed by the WhatsUp Setup. 
7 Click Next. The WhatsUp Setup invokes the installation program for each of the 

products you selected for installation.   

 Note: Each product's install program will be invoked and will run separately. For more 
information, see the install instructions for the products you selected for installation.  

When all of the selected products have been installed, the Installation Complete dialog 
appears.  

8 Click Finish. The WhatsUp Setup closes. 
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Installing WhatsUp Gold 

 Note: The installation instructions in this document apply only to WhatsUp Gold Standard 
Edition and WhatsUp Gold Premium Edition. For installation instructions for WhatsUp Gold 
Distributed Edition or WhatsUp Gold MSP Edition, see WhatsUp Gold Distributed Edition 
Deployment Guide (http://www.whatsupgold.com/WUG15dsdg) or WhatsUp Gold MSP Edition 
Deployment Guide (http://www.whatsupgold.com/WUG15mspdg). 

 Note: If you are installing WhatsUp Gold on a Windows 2003 Server, you must first install IIS 
6.0 on the server prior to running the installation utility. For information on how to install and 
configure IIS, see Installing IIS on Windows Server 2003 (on page 25). 

 Note: To launch the WhatsUp Gold installation program, you must run the WhatsUp Setup. 
For more information see Running WhatsUp Setup (on page 8). 

To install WhatsUp Gold using the installation program: 
1 Read the Welcome screen. 

 Tip: Click a link to view a Help resource. 

Click Next. The License Agreement dialog appears. 
2 Read the license agreement. If you accept the terms of the license agreement, select I 

accept the terms of the license agreement.  

 To print a copy of the license agreement, click Print. The license agreement is sent to 
the default printer. 

 If you do not accept the terms of the license agreement, click Cancel to exit the 
installation program. 

Click Next to continue. The Enter Microsoft SQL Server 2005 Express Edition Paths dialog 
appears. 

3 Select the install directories for Microsoft SQL Server 2005 Express Edition. The 
application and data files are installed in default directories. To change the locations, 
click Browse to find and select a different directory for the application files or the data 
files. 

 Important: Make sure that you have a large capacity drive selected for data storage. The 
data files for WhatsUp Gold can reach a maximum size of 22 GB. 

 Important: During the initial installation, databases are created for WhatsUp Gold Flow 
Monitor. These initial databases are limited in size, but are increased the first time the Flow 
Monitor collector initializes. If at least 16 GB of disk space are available when the collector 
initializes, the maximum size of the Flow Monitor databases is increased to 4 GB each (16 GB 
total including transaction logs). If less than 16 GB is available, the maximum size of the Flow 
Monitor databases is limited proportionately to the amount of free disk space. If your license 
includes WhatsUp Gold Flow Monitor, we strongly recommend that you verify that you have 
at least 16 GB of free disk space before installing. 

http://www.whatsupgold.com/WUG15dsdg
http://www.whatsupgold.com/WUG15mspdg
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Click Next. The Specify the SQL "sa" Account Password dialog appears. 

 Important: If you want to change the SQL Server user account, the account you want to use 
must have the same permissions as the 'sa' account.  The password you create must meet 
any password complexity rules enforced by the local server or domain. 

4 Specify a User Name for the account and enter and confirm a Password. You also have 
the option to Keep the default password.  

Click Next. The WhatsUp Gold installation directory dialog appears. 
5 Select the installation directory for the WhatsUp Gold application files. 

The default path is C:\Program Files\Ipswitch\WhatsUp. We recommend that you 
use the default path. After you select the installation directory, click Next. The Choose 
Port dialog appears. 

 Tip: The Program Files directory path may vary if on a 64 bit system (for example, Program 
Files (x86)). You can install WhatsUp Gold to a different location. To select a different 
location, click Change. 

 Note: If the installation program detects data from a previous installation of WhatsUp Gold, 
the Backup Web and Report Files dialog appears. We recommend that you select Back up 
the existing Web and report files, then click Next. 

6 Choose a TCP port for the WhatsUp Gold web site. The installation program creates an 
IIS web site using this port. The default port is 80.  

 Note: It is recommended that port 80 be used for the WhatsUp Gold web site. If another port 
number is used, the URL for the WhatsUp Gold web site will require that port number to be 
appended to the hostname or IP address when forming the URL.  For example if you chose 
8888 as the port number instead of 80 your URL for a WhatsUp Gold install on the local host 
would be: localhost/nmconsole:8888 

 Note:If port 80 is used by a current IIS web site, you must either allow WhatsUp Gold to 
disable that web site and take over port 80, or choose another port. 

Click Next. The Ready to Install the Program dialog appears. 
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7 Click Install. The WhatsUp Gold install program begins the installation. 

When the installation program completes, the InstallShield Wizard Complete dialog 
appears.  
Click Finish. The setup program closes. The WhatsUp Setup will appear, and the WhatsUp 
Gold Web interface will appear. 

 

Installing WhatsUp Gold using advanced options 

 Note: The installation instructions in this document apply only to WhatsUp Gold Standard 
Edition and WhatsUp Gold Premium Edition. For installation instructions for WhatsUp Gold 
Distributed Edition or WhatsUp Gold MSP Edition, see WhatsUp Gold Distributed Edition 
Deployment Guide (http://www.whatsupgold.com/WUG15dsdg) or WhatsUp Gold MSP Edition 
Deployment Guide (http://www.whatsupgold.com/WUG15mspdg). 

 Note: If you are installing WhatsUp Gold on a Windows 2003 Server, you must first install IIS 
6.0 on the server prior to running the installation utility. For information on how to install and 
configure IIS, see Installing IIS on Windows Server 2003 (on page 25). 

 Note: To launch the WhatsUp Gold installation program, you must run the WhatsUp Setup. 
For more information see Running WhatsUp Setup (on page 8). 

The WhatsUp Gold installation program provides advanced options that allow you to: 

 Use and existing Microsoft SQL Server 2005, Microsoft SQL Server 2008 or 2008 R2, or 
Microsoft SQL Server Cluster 2005, 2008, or 2008 R2 to store the data collected by 
WhatsUp Gold. 

 Change the WhatsUp Gold and Flow Monitor database names.   

 Note: You can only change the default database names during the initial WhatsUp Gold 
installation. You cannot change the names of these databases following the initial 
installation.  

 Note: The default database name for the WhatsUp Gold database is WhatsUp, and the 
default name for the Flow Monitor database is Netflow.  

 Create a new Windows user account for WhatsUp Gold and add the user to the local 
administrators group. 

 Note: The Windows user created during this step will enable all applications launched from 
the WhatsUp Web Interface through IIS to run and make connections with the WhatsUp 
database using Windows authentication.  

http://www.whatsupgold.com/WUG15dsdg
http://www.whatsupgold.com/WUG15mspdg
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Prerequisites for using an existing Microsoft SQL Server 2005, 
Microsoft SQL Server 2008 or 2008 R2, or Microsoft SQL Server 
Cluster 2005, 2008, or 2008 R2 
You can use an existing Microsoft SQL Server 2005, Microsoft SQL Server 2008 or 2008 R2, or 
Microsoft SQL Server Cluster 2005, 2008, or 2008 R2 to store the data collected by WhatsUp 
Gold. To do this, you must meet the following requirements: 

 Microsoft SQL Server 2005, Microsoft SQL Server 2008 or 2008 R2, or Microsoft SQL 
Server Cluster 2005, 2008, or 2008 R2 English must be installed on the WhatsUp Gold 
host computer or another computer. 

 Important: Make sure that the "master" database for the existing SQL Server database 
instance that is hosting the WhatsUp database is configured to use case-insensitive collation. 

 Important: WhatsUp Gold does not support non-English versions of Microsoft SQL Server 
2005, Microsoft SQL Server 2008 or 2008 R2, or Microsoft SQL Server Cluster 2005, 2008, or 
2008 R2. 

 Important: Make sure that, if WhatsUp Gold and the SQL Server is not located on the same 
physical machine (server), the system clocks are synchronized to the same time zone. If the 
system clocks are not synchronized, inaccurate data may occur in reports. 

 Microsoft SQL Server 2005, Microsoft SQL Server 2008 or 2008 R2, or Microsoft SQL 
Server Cluster 2005, 2008, or 2008 R2 must be configured to allow WhatsUp Gold to 
authenticate.  

 If Microsoft SQL Server is installed on a remote computer, remote connections must 
be allowed. For more information, see How to configure Microsoft SQL Server to allow 
remote connections (, http://blogs.msdn.com/b/walzenbach/archive/2010/04/14/how-
to-enable-remote-connections-in-sql-server-2008.aspx). 

 Use a Microsoft SQL Server user account to connect to the database.  

 Microsoft SQL Server must be configured to have a user account that meets the 
following requirements: 

 Full administrator privileges to Microsoft SQL Server, not just the WhatsUp Gold 
databases. WhatsUp Gold only supports accessing the database via an account with 
full administrator rights. WhatsUp Gold does not support using a limited access 
database user account. 

 User's language is set to (United States) English. This can be set in the 
properties for the login used by WhatsUp Gold. 

If you need assistance configuring or verifying these prerequisites, contact your database 
administrator or refer to the Microsoft SQL Server documentation 
(http://support.microsoft.com/ph/2855). 

http://blogs.msdn.com/b/walzenbach/archive/2010/04/14/how-to-enable-remote-connections-in-sql-server-2008.aspx
http://blogs.msdn.com/b/walzenbach/archive/2010/04/14/how-to-enable-remote-connections-in-sql-server-2008.aspx
http://support.microsoft.com/ph/2855
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To install WhatsUp Gold using advanced options: 
1 If you are asked to install the required role services, click Yes. The installation program 

installs the required IIS components. 

 Note: When IIS is detected, but not all of the required role services are installed, you will be 
asked if you would like to install the IIS role services. 

2 Read the Welcome screen. 

 Tip: Click a link to view a Help resource. 

3 Clear Hide advanced installation options. This option must be cleared in order for you 
to use the advanced installation options. 

Click Next. The License Agreement dialog appears. 

4 Read the license agreement. If you accept the terms of the license agreement, select I 
accept the terms of the license agreement.  

 To print a copy of the license agreement, click Print. The license agreement is sent to 
the default printer. 

 If you do not accept the terms of the license agreement, click Cancel to exit the 
installation program. 

5 Select one of the <MSSSQL> Installation options, then click Next. 

 Note: If you want to use and existing local or remote installation of Microsoft SQL Server 
2005, or Microsoft SQL Server 2008 or 2008 R2 in support of WhatsUp Gold, select the option 
allowing you to choose an existing Microsoft SQL Server 2005 or Microsoft SQL Server 2008 
or 2008 R2 database. 

6 If you selected to use an existing local or remote installation of Microsoft SQL Server 
2005, or Microsoft SQL Server 2008 or 2008 R2 for use with WhatsUp Gold, the Database 
Server Login dialog appears. Enter the database server address and SQL Server 
authentication information in this dialog. 

 Important: Make sure that the "master" database for the existing SQL Server database 
instance that is hosting the WhatsUp database is configured to use case-insensitive collation. 

 Tip: If you cannot remember your database server's hostname, click Browse to see a list of 
all database servers detected on the domain. Database servers to which you can connect but 
which are not configured on the same domain as the computer where you are installing 
WhatsUp Gold are not shown. The Browse dialog scans your entire domain, so it may take 
some time before showing you a list of database servers. 
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a) In Database server that you are installing to, enter the hostname, or hostname and 
instance of your database server. 

 Note: If you are using a database instance other than the default instance, you must include 
the instance name using the format <Server_Name>\<Instance_Name>. 

b) In SQL Server Authentication, enter the correct Login ID and Password. 

 Important: If you want to change the SQL Server user account, the account you want to use 
must have the same permissions as the 'sa' account. 

c) Click Next. The installation program attempts to validate the credentials you entered 
and checks for the existence of WhatsUp Gold databases on the database server.  
If WhatsUp Gold databases are found on the database server, the setup program 
alerts you and asks if you want to continue.  

 Select Yes to upgrade the databases and continue the installation. 

 Select No to select another Microsoft SQL Server. After the credentials are 
validated, the Enter Microsoft SQL Server 2005 Express Edition Paths dialog 
appears. 

7 If you selected to install Microsoft SQL Server 2005 Express Edition on the local machine, 
the Enter Microsoft SQL Server 2005 Express Edition Paths dialog appears. Perform the 
following:  

a) Select the install directories for Microsoft SQL Server 2005 Express Edition. The 
application and data files are installed in default directories. To change the locations, 
click Browse to find and select a different directory for the application files or the data 
files. 

 Important: Make sure that you have a large capacity drive selected for data storage. The 
data files for WhatsUp Gold can reach a maximum size of 22 GB. 

 Important: During the initial installation, databases are created for WhatsUp Gold Flow 
Monitor. These initial databases are limited in size, but are increased the first time the Flow 
Monitor collector initializes. If at least 16 GB of disk space are available when the collector 
initializes, the maximum size of the Flow Monitor databases is increased to 4 GB each (16 GB 
total including transaction logs). If less than 16 GB is available, the maximum size of the Flow 
Monitor databases is limited proportionately to the amount of free disk space. If your license 
includes WhatsUp Gold Flow Monitor, we strongly recommend that you verify that you have 
at least 16 GB of free disk space before installing. 

b) Click Next. The Specify the SQL "sa" Account Password dialog appears. 
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c) Specify a User Name for the account and enter and confirm a Password. You also 
have the option to Keep the default password. 

 Important: If you want to change the SQL Server user account, the account you want to use 
must have the same permissions as the 'sa' account.  The password you create must meet 
any password complexity rules enforced by the local server or domain. 

Click Next. The Database Names dialog appears. 

8 If you selected to use an existing local Microsoft SQL Server 2008 or 2008 R2 database or 
an existing remote Microsoft SQL Server 2005 database, use the Microsoft SQL Server 
2005 Express Edition Paths dialog to install the Microsoft SQL Server 2005 Express 
Edition client tools (required for installations of WhatsUp Gold that use Microsoft SQL 
Server databases). Perform the following to select install directories for the Microsoft 
SQL Server 2005 Express Edition database tools:  

a) Select the install directories for the Microsoft SQL Server 2005 Express Edition tools. 
The application and data files are installed in default directories.  

b) To change the locations, click Browse to find and select a different directory for the 
application files or the data files. 

 Note: If you selected to use an existing Microsoft SQL Server 2005 database installed on the 
local server, the database tools will already be installed. 

Click Next. The Database Names dialog appears. 

9 Type any changes you want to make to the WhatsUp database and Netflow database 
names. 

 Note: The database names must be in English and must use alpha-numeric characters (A-
Z,a-z,0-9 and the underscore character "_" ). 

 Note: You can only change the default database names during the initial WhatsUp Gold 
installation. You cannot change the names of these databases following the initial 
installation.  

 Note: The default database name for the WhatsUp Gold database is WhatsUp, and the 
default name for the Flow Monitor database is Netflow.  

 Note: The Netflow Archive database will use the Flow Monitor database name with the 
letters 'Ar' appended to the end.  The default name for the Flow Monitor Archive database is 
NFArchive.   

Click Next. The Choose Destination Location dialog appears. 
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10 Select the installation directory for the WhatsUp Gold application files. 

The default path is C:\Program Files\Ipswitch\WhatsUp. We recommend that you 
use the default path. After you select the installation directory, click Next. The Choose 
Port dialog appears. 

 Tip: The Program Files directory path may vary if on a 64 bit system (for example, Program 
Files (x86)). You can install WhatsUp Gold to a different location. To select a different 
location, click Change. 

 Note: If the installation program detects data from a previous installation of WhatsUp Gold, 
the Backup Web and Report Files dialog appears. We recommend that you select Back up 
the existing Web and report files, then click Next. 

 Click Next. The Choose Port dialog appears. 
11 Choose a TCP port for the WhatsUp Gold web site. The installation program creates an 

IIS web site using this port. The default port is 80.  

 Note: It is recommended that port 80 be used for the WhatsUp Gold web site. If another port 
number is used, the URL for the WhatsUp Gold web site will require that port number to be 
appended to the hostname or IP address when forming the URL.  For example if you chose 
8888 as the port number instead of 80 your URL for a WhatsUp Gold install on the local host 
would be: localhost/nmconsole:8888 

 Note:If port 80 is used by a current IIS web site, you must either allow WhatsUp Gold to 
disable that web site and take over port 80, or choose another port. 

Click Next. The Specify a Windows user account and password dialog appears. 
12 Specify a User Name for the Windows user account and enter and confirm a Password.  

Click Next. The Ready to Install the Program dialog appears. 
13 Click Install. The WhatsUp Gold install program begins the installation. 
14 When the installation program completes, the InstallShield Wizard Complete dialog 

appears.  
Click Finish. The setup program closes. The WhatsUp Setup will appear, and the 
WhatsUp Gold Web interface will appear. 
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Activating WhatsUp Gold for new or upgraded 
licenses 

If WhatsUp Gold is installed using the installation application downloaded from the Web link 
provided in the purchase confirmation email, the program is fully functional immediately 
after installation.  

If the license is not automatically activated during the installation or if you are upgrading 
from a previous version, you can manually activate WhatsUp Gold. 

 Important: Make sure that you activate WhatsUp Gold before starting the application. If the 
application is not activated before the polling engine is started, the engine will not start and 
a message telling you that the license has expired is written to the log. The application is not 
functional until after it has been activated. 

To activate WhatsUp Gold manually: 

 Note: Before you start the manual activation process, make sure that you have your product 
Activation Key available to use in the activation program. 

1 Click Start > Programs > Ipswitch WhatsUp Gold > Manage WhatsUp Gold License. 
The activation program appears. 
- or - 
If you run the WhatsUp Gold console at the end of the installation, it displays an Invalid 
License dialog. Click the Purchase/Unlock to start the license activation process. 

2 Follow the on-screen instructions to complete the product activation. 

 Note: When the activation is complete, a confirmation page indicates the license has been 
activated. If the activation does not complete successfully, you may be behind a proxy or 
firewall that is blocking the activation request. In this case, click the Offline button, then 
follow the onscreen instructions. 

For more help and information about licensing, go to the MyIpswitch licensing portal 
(http://www.myipswitch.com/). 

 Tip: You can view information about your installation via the About WhatsUp Gold dialog, 
located on both the console and web interface from Help > About WhatsUp. The About 
WhatsUp Gold dialog displays your license type, serial number, product edition, registered 
user, maximum devices. From the About WhatsUp Gold dialog, you can click Plugins to view 
the plugin licensing information. 

 

http://www.myipswitch.com/
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Upgrading WhatsUp Gold 

The installation program can automatically upgrade WhatsUp Gold v12 and later. The 
installation program delivers new application files and upgrades the database. The 
installation program automatically upgrades databases on Microsoft SQL Server Desktop 
Edition, Microsoft SQL Server 2005 Express Edition, Microsoft SQL Server 2005, and Microsoft 
SQL Server 2008 or 2008 R2. 

 Note: WhatsUp Gold v12.3 or later introduces automatic database upgrades. It is no longer 
necessary to manually execute SQL scripts to upgrade a non-standard database. 

 Note: If you are using Microsoft SQL Server 2000, you must upgrade to Microsoft SQL Server 
2005, Microsoft SQL Server 2008 or 2008 R2, or Microsoft SQL Server Cluster 2005, 2008, or 
2008 R2 prior to upgrading WhatsUp Gold. Microsoft SQL Server 2000 is no longer supported 
by WhatsUp Gold. 

 Tip: To upgrade from an older version than WhatsUp Gold v12, you must follow a supported 
upgrade path. For more information on supported upgrade paths, see the Updating from 
versions 8.x, 2005, or 2006 to v14.x (http://www.whatsupgold.com/wug14upgrade) 
Knowledge Base article or refer to the WhatsUp Gold Answers repository 
(http://whatsup.custhelp.com). 

If the database is currently hosted on Microsoft SQL Server Desktop Edition or Microsoft SQL 
Server 2005 Express Edition but you want to migrate your database to Microsoft SQL Server 
2005, Microsoft SQL Server 2008 or 2008 R2, or Microsoft SQL Server Cluster 2005, 2008, or 
2008 R2, complete the upgrade on the existing database, then follow the steps outlined in 
the WhatsUp Gold Database Migration Guide (http://www.whatsupgold.com/wugdbmg_15). 

To upgrade WhatsUp Gold: 

 Note: To launch the WhatsUp Gold installation program, you must run WhatsUp Setup. For 
more information see Running WhatsUp Setup (on page 8). 

1 On the WhatsUp Setup Install Options dialog, select the WhatsUp Gold version you want 
to which you want to upgrade. The status will show a message detailing the version 
being upgraded.  

http://www.whatsupgold.com/wug14upgrade
http://whatsup.custhelp.com/
http://www.whatsupgold.com/wugdbmg_15
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2 If you are asked to install the required role services, click Yes. The installation program 
installs the required IIS components. 

 Note: When IIS is detected, but not all of the required role services are installed, you will be 
asked if you would like to install the IIS role services. 

 Note: You will need to install IIS if you are upgrading from a WhatsUp Gold installation that 
uses the WhatsUp Gold web server, as it is no longer supported, or if you are installing on 
Windows Server 2003 (you must install IIS6 for Windows Server 2003). When installing on 
operating systems that support IIS7, the installation program will automatically install IIS7 if 
it is not installed. 

3 The Welcome dialog appears. It provides the WhatsUp Gold version to which the setup 
program will upgrade the installed WhatsUp Gold system. 

4 Read the Welcome screen. 

 Tip: Click a link to view a Help resource. 

5 Click Next. The License Agreement dialog appears. 
6 Read the license agreement. If you accept the terms of the license agreement, select I 

accept the terms of the license agreement.  

 To print a copy of the license agreement, click Print. The license agreement is sent to 
the default printer. 

 If you do not accept the terms of the license agreement, click Cancel to exit the 
installation program. 

Click Next. The Back Up Existing Database dialog appears. 

7 Since the installation program makes changes to the WhatsUp Gold database, we 
strongly recommend that you select Yes, back up the existing database.  

Click Next. The Back Up Web and Report Files dialog appears. 

8 If you have modified any of the Web or Report files, select Back up the existing Web 
and report files. If this option is selected, the existing Web and report files are copied to 
a backup folder before the upgrade begins. We recommend that you select this option. 

Click Next. The Choose Port dialog appears. 

9 Choose a TCP port for the WhatsUp Gold web site. The installation program creates an 
IIS web site using this port. The default port is 80.  

 Note: It is recommended that port 80 be used for the WhatsUp Gold web site. If another port 
number is used, the URL for the WhatsUp Gold web site will require that port number to be 
appended to the hostname or IP address when forming the URL.  For example if you chose 
8888 as the port number instead of 80 your URL for a WhatsUp Gold install on the local host 
would be: localhost/nmconsole:8888 

 Note:If port 80 is used by a current IIS web site, you must either allow WhatsUp Gold to 
disable that web site and take over port 80, or choose another port. 
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 Note:If you selected to use port 80 on the Choose Port dialog and port 80 is in use by an 
existing web site, a message will appear that asks if you want the WhatsUp Gold installation 
program to take over port 80 for use by the 'WhatsUp Gold web site. If you want the 
WhatsUp Gold installation program to take over port 80, click Yes. Otherwise, click No. The 
dialog closes and the Choose Port dialog appears. 

Click Next. The Ready to Install the Program dialog appears. 
10 Click Install. The installation program upgrades the necessary components. 
11 When the installation program completes, the InstallShield Wizard Complete dialog 

appears.  
Click Finish. The setup program closes. The WhatsUp Setup will appear, and the 
WhatsUp Gold Web interface will appear. 

Updating user accounts after upgrade 
When upgrading from WhatsUp Gold v14.x or earlier to WhatsUp Gold v15.0 or later, user 
accounts that had been granted the Manage User user right may not have access to portions 
of the web interface, such as the Admin Panel on the Admin tab.  It may appear as if these 
user accounts have all of the available user rights, however the user account does not actually 
have any of the new user rights released in the WhatsUp Gold v15.0 or later releases, and the 
account will need to be updated before the user rights actually assigned to the user account 
are displayed properly.   

To update a user account following upgrade: 
1 Navigate to the Manage Users dialog (Admin > Manage Users) 
2 Select the user account you want to update, then click Edit. The Edit User Account 

dialog appears.  
3 Without making any changes, click OK. The user account is updated  
4 Log out of the WhatsUp Gold web interface, then log back in to the WhatsUp Gold web 

interface.  
5 Verify that the user account displays the user rights actually assigned to the account. 
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Repairing WhatsUp Gold 

 Note: To launch the WhatsUp Gold installation program, you must run WhatsUp Setup. For 
more information see Running WhatsUp Setup (on page 8). 

To repair WhatsUp Gold: 
1 On the WhatsUp Setup Install Options dialog, select the WhatsUp Gold version you want 

to which you want to repair. Continue with WhatsUp Setup using instructions provided 
in Running WhatsUp Setup (on page 8). The Welcome dialog of the WhatsUp installation 
program will appear. 

2 Select Repair to reinstall all program features installed by the previous setup. 

 Tip: Select Remove to uninstall WhatsUp Gold. 

Click Next. The Back Up Existing Database dialog appears. 

3 Since the installation program makes changes to the WhatsUp Gold database, we 
strongly recommend that you select Yes, back up the existing database.  

Click Next. The Back Up Web and Report Files dialog appears. 

4 If you have modified any of the Web or Report files, select Back up the existing Web 
and report files. If this option is selected, the existing Web and report files are copied to 
a backup folder before the upgrade begins. We recommend that you select this option. 

Click Next. The Setup Type dialog appears. 
5 Select Repair IIS configuration to repair the current IIS configuration. 

 Tip: Select Don't change current IIS configuration, if you do not want to change the 
current IIS configuration. 

Click Next. The Ready to Install the Program dialog appears. 

6 When the installation program completes, the InstallShield Wizard Complete dialog 
appears.  
Click Finish. The setup program closes. The WhatsUp Setup will appear, and the 
WhatsUp Gold Web interface will appear. 
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Uninstalling WhatsUp Gold 

To uninstall WhatsUp Gold: 
1 Launch the install program from the WhatsUp Setup: 

a) Run the WhatsUp Setup. For more information, see Running WhatsUp Setup (on page 
8). On the Install Options dialog, select the WhatsUp Gold product option, then click 
Next. 

 Note: The WhatsUp Setup program detects any currently installed Ipswitch WhatsUp 
branded software and determines which installation options are available (New Installation, 
Upgrade, Repair or Un-install). This information is displayed to the right of the product 
name and version. 

b) On the License Information dialog, select Use existing installed license, then click 
Next.  

c) On the Installation Summary dialog, ensure that the currently installed version of 
WhatsUp Gold is displayed as the product selected for repair or uninstall, then click 
Next. The Welcome dialog of the Whatsup Gold Installation program will appear. 

d) Select Remove to uninstall WhatsUp Gold. 

 Tip: Select Repair to reinstall all program features installed by the previous setup. 

Click Next. 

- OR - 
2 Launch the install program from the Programs and Features dialog: 

a) Navigate to the Control Panel dialog (Start > Control Panel).  

b) Click Uninstall a Program. The Uninstall or change a program dialog will appear and 
populate with all of the installed programs. 

c) Select the version of Ipswitch WhatsUp Gold you want to uninstall. 

d) Click Uninstall. The Whatsup Gold installation program will appear. 
3 Select one of the following options: 

 If you want to remove WhatsUp Gold but maintain your configuration data, select 
Keep my configuration data, but uninstall Ipswitch WhatsUp Gold v15 . The 
configuration data includes device definitions, custom monitors, users, recurring 
reports and historical poll data. 

 If you want to remove your configuration data and uninstall Ipswitch WhatsUp Gold 
v15,  select Remove my configuration data and uninstall Ipswitch WhatsUp Gold 
v15.  
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 If you selected Remove my Configuration data and uninstall Ipswitch WhatsUp 
Gold v15 and you want to remove the WhatsUp SQL Server Express Edition instance 
created during the install, select  Also, remove the WhatsUp instance of SQL Server 
Express. 

 Note: If you remove the configuration data, it cannot be recovered. If you maintain your 
configuration data, you can re-install WhatsUp Gold and restore the saved configuration. 

 Note: If you remove the WhatsUp instance of SQL Server Express, any other database 
created on the instance will be lost. 

A confirmation screen will appear.  
1 Click Yes to remove WhatsUp Gold. The Setup Status dialog appears. 

The setup status dialog shows the status of the uninstall.  When the uninstall is complete, 
the Uninstall Complete dialog appears. 

2 Select Yes, I want to restart my computer now.  

Click Finish. The Uninstall Complete dialog closes and your computer will shutdown and 
restart. 

 

About device count limits 

WhatsUp Gold is licensed by the number of monitored devices. After the number of 
monitored devices has been reached, you cannot add new devices to WhatsUp Gold. 

To view the number of devices your license allows and the number of devices you have 
currently configured: 
1 From the console, select Help > About WhatsUp. The About WhatsUp dialog appears. 

- or - 

From the web interface, select Help > About WhatsUp. The About WhatsUp dialog 
appears. 

2 Maximum Devices indicates the number of devices your license allows you to monitor. 
The total number of devices currently configured in WhatsUp Gold is indicated in the 
first paragraph. 

 Tip: You can upgrade your license to include more devices through the Ipswitch customer 
portal (http://www.myipswitch.com). 

 

http://www.myipswitch.com/
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About the Task Tray and Desktop Actions 
applications 

WhatsUp Gold installs two task bar icons on your computer.  

 The Task Tray icon  alerts you to the status of the application as a whole. 

 The Desktop Actions icon  displays to indicate that the application for Sound and 
Text-to-Speech actions is turned on. 

 Note: Desktop Actions must be running for the Sound and Text-to-Speech actions to work. 

WhatsUp Gold Icons 
During normal operation, the Task Tray icon displays the worst state of all devices on your 
map.  

 Tip: You can enable tooltips to have the icon display any state change that occurs on the 
system. To do this, right-click on the icon and select or clear Enable Tooltips. 

 

When the WhatsUp Gold service is stopped and the polling engine is not running, this icon 
appears: 

 

In this case, you need to restart the WhatsUp Polling Engine service. If the polling engine is 
not running, WhatsUp Gold is not connected to the database, and nothing in the application 
functions properly. 

 To turn off the Task Tray Application and icon , right-click on the icon, then click 
Close Task Tray Application. 

 To turn off the Desktop Actions icon , right-click the icon, then click select Close. 

 Note: Sound and Text-to-Speech actions are disabled when you close the Desktop Actions 
icon. 
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Installing IIS on Windows Server 2003 

Use the following procedure to enable the required IIS Web Extension and install IIS if it has 
not been installed. 

The required Web Extension is Active Server Pages (ASP). 

 Note: You will need to provide your Windows Server 2003 Enterprise x64 Edition CD-ROM to 
copy files necessary to install IIS. 

To install IIS  and the required Web Extensions on Windows Server 2003: 
1 Install Internet Information Services (IIS). 

a) Navigate to the Programs and Features dialog (Start > Settings > Control Panel > 
Add or Remove Programs). The Add or Remove Programs dialog appears. 

b) From the pane on the left side of the window, select Add/Remove Windows 
Components. The Windows Components Wizard appears. 

c) Select Application Server. 

 Note: You will need to provide your Windows Server 2003 Enterprise x64 Edition CD-ROM to 
copy files necessary to install IIS. 

d) Click Next. Setup installs IIS. 
2 Allow Active Server Pages as a Web Service Extension. 

a) Navigate to the Internet Information Services (IIS) Manager. (Start > Settings > 
Control Panel > Administrative Tools > Internet Information Services (IIS) 
Manager). The Internet Information Services Manager appears.  

b) Select Web Service Extensions in the left pane. The Web Services Extensions dialog 
appears in the right pane. 

c) Select Active Server Pages, and click Allow. The Active Server Pages extension is 
allowed. 

3 Close the IIS Manager. You can now run the WhatsUp Gold installation program. 
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Using Windows Authentication for remote database 
access 

Prerequisites 
Before you begin, you must have access to the following: 

 Remote Microsoft SQL Server server 

 Computer on which to install WhatsUp Gold 

 Note: The computer on which you are going to install WhatsUp Gold must be on the same 
domain as the Microsoft SQL Server server. 

 Domain user account (called user1 in this example) 

For details regarding minimum hardware and software requirements, see System 
Requirements. 

Overview 
To configure a WhatsUp Gold installation to use Windows Authentication for remote 
Microsoft SQL Server database access: 

1 Add the domain user to the Local Administrator group on the machine that will host 
WhatsUp Gold. 

2 Add the domain user to the Local Administrator group on the machine that is hosting 
Microsoft SQL Server. 

3 Add the domain user (e.g. user1) to the Microsoft SQL Server database using the Login 
dialog. 

4 Assign the same permissions that are assigned to the Microsoft SQL Server 'sa' user to 
the Domain User (user1) in the Microsoft SQL Server database. 

5 Install WhatsUp Gold with a local Microsoft SQL Server 2005 Express Edition database. 
6 Run the Database Configuration utility and configure the WhatsUp Gold database 

connection to connect to the remote database using WIndows Authentication. 
7 Configure the ODBC driver to connect to the remote database using Windows 

Authentication.  
8 Configure IIS to use the Domain User for the NMConsole application pool and change 

the anonymous access user account to the Domain User for the WhatsUp Gold web site. 
9 Configure the Ipswitch Services Control Manager to use the Domain User to run the 

WhatsUp Gold processes. 
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Creating and adding the domain user to the WhatsUp Gold and 
Microsoft SQL Server host machines 
To add the domain user to the Local Administrators group on the machine that will host 
WhatsUp Gold: 
1 Log in to Windows as a local administrator on the machine that will host WhatsUp Gold. 
2 Create the domain user, or otherwise determine which domain user (e.g. user1) you 

want WhatsUp Gold to connect to the remote Microsoft SQL Server database.  

Use the following steps to create a domain user: 

a) Open Microsoft Management Console by clicking the Start button , typing mmc into 
the Search box, and then pressing ENTER.   If you are prompted for an administrator 
password or confirmation, type the password or provide confirmation. 

b) In the left pane of Microsoft Management Console, click Local Users and Groups. 

c) Click the Users folder. 

d) Click Action, and then click New User. 

e) Type the appropriate information in the dialog box, and then click Create. 

f) When you are finished creating user accounts, click Close. 
3 Add the selected domain user (e.g. user1) to the Local Administrator group. 

a) In the left pane of Microsoft Management Console, click Local Users and Groups. 

b) Double-click the Groups folder. 

c) Right-click the Local Administrator group, and then click Add to Group. 

d) Click Add, and then type the name of the user account. 

e) Click Check Names, and then click OK. 
4 Restart the computer (optional, but recommended). 

To add the domain user to the Local Administrators group on the machine that is 
hosting the Microsoft SQL Server database: 
1 Log in to Windows as a local administrator on the machine that is hosting the Microsoft 

SQL Server database. 

 Note: The MSSQL server must be on the same domain as the WhatsUp Gold server. 

2 Add the selected domain user (e.g. user1) to the Local Administrator group. 

a) In the left pane of Microsoft Management Console, click Local Users and Groups. 

b) Double-click the Groups folder. 

c) Right-click the Local Administrator group, and then click Add to Group. 

d) Click Add, and then type the name of the user account. 

e) Click Check Names, and then click OK. 
3 Restart the computer (optional, but recommended). 
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Adding the domain user as a Microsoft SQL Server database user 
To create a SQL Server login that uses Windows Authentication (SQL Server 
Management Studio) 
1 Launch the SQL Server Management Studio. 
2 Add the domain user: 

a) In SQL Server Management Studio, open Object Explorer and expand the folder of the 
server instance in which to create the new login. 

b) Right-click the Security folder, select New, and then click Login. 

c) On the General page, enter the domain user name (e.g. user1) in Login name. 

d) Select Windows Authentication. 

e) Click OK. 
3 Provide the domain user (e.g. user1) with the same permissions as the Microsoft SQL 

Server system administrator (sa) user. The following is a guideline that provides the most 
common settings for the 'sa' user.  

 On the Server Roles page, select the sysadmin role. 

 On the User Mapping page - Select the db_owner role membership for each database. 
If you do not wish the domain user to have access to a specific database, do not 
provide db_owner (dbo) role membership for that database. 

 On the Status page in the Settings menu: 

 Select Grant for Permission to connect to database engine. 

 Select Enabled for Login. 
4 Save your changes and exit SQL Server Management Studio. 

Installing WhatsUp Gold and configuring the connection to the 
remote database 
To configure WhatsUp Gold and connect to the remote database: 
1 Log in to the machine that you  using the domain user (e.g. user1) on the WhatsUp Gold 

server. 
2 Install WhatsUp Gold. Use all of the default settings, allowing the Microsoft SQL Server 

2005 Express Edition database to install locally. 

 Note: Because of service dependencies, you must allow the local database to install and run. 
It is possible remove this dependency later. 

3 After the WhatsUp Gold installation completes, run RemoteDBConfig.exe, using 
Windows authentication, and point it at the remote database server. (Start > Programs 
> Ipswitch WhatsUp Gold v15 > Utilities > Database Configuration Utility) 

a) Locate the RemoteDBConfig.exe file in the default location: C:\Program Files 
(x86)\Ipswitch\WhatsUp, or in the custom location where you installed WhatsUp 
Gold. 
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b) Double-click the RemoteDBConfig.exe file. The Database Connection dialog 
appears. 

c) Check to make sure the Server Name is correct for the location of your local SQL server 
for WhatsUp Gold. 

d) Browse for the remote SQL server you want to use. 

e) In the Authentication section, select Windows Authentication. 

 Note: You must be logged in as the domain user (e.g. user1). 

f) Click Connect. 

g) Click Continue to update the databases. 

h) Click Finish to exit. 

 Note: If you see BCP errors, delete the WhatsUp and NetFlow databases on the remote SQL 
server and try running RemoteDBConfig.exe again. 

Set up the ODBC connection on the machine hosting WhatsUp Gold 
1 Set up the ODBC connection to use Windows Authentication and the remote SQL 

database server.  

a) On 32-bit systems, click Start > Settings > Control Panel, then double-click the 32bit 
ODBC icon. 
- or - 
On 64-bit systems, locate the C:\Windows\SysWOW64 folder, and double-click the 
ODBCAD32.exe icon. 

b) Select the System DSN tab. 

c) Select NetFlow. 

d) Click Configure. 

e) Select the remote SQL server from the Server list. 

f) Click Next. 

g) Select With Windows NT authentication using the network login ID. 

h) Continue clicking Next, accepting the current settings. Save the changes and exit. 

i) Repeat steps b through g for all other sources. 
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Configure WhatsUp Gold to use Windows Authentication 
1 Run NmConfig.exe to configure WhatsUp Gold to use Windows authentication: 

a) Click Start > Programs > Ipswitch WhatsUp Gold v15.0 > Utilities > Database 
Configuration Utility. 

b) Select Use Windows Authentication. 

c) Click Connect. 

d) Ensure Restart the WhatsUp services after the update is selected. 

e) Click Save. 

Configure IIS on the machine hosting WhatsUp Gold 
For operating systems that use IIS6, you must add the domain user account to the IIS_WPG 
group and change the identity for the NmConsole application pool to the domain user, and 
configure the account used for anonymous authentication to the domain user (e.g. user1). 
For operating systems using IIS7, you only need to change the identity for the NmConsole 
application pool, and configure the account used for anonymous authentication. The 
following procedures provide information on performing these tasks. 

To add the domain user account (e.g. user1) to the IIS_WPG group on IIS6 
1 On the desktop, right-click My Computer, and then click Manage. 
2 In the Computer Management screen, under System Tools, expand Local Users and 

Groups, and then click Groups. 
3 Right-click the IIS_WPG group, and then click Add to Group. 
4 In the IIS_WPG Properties dialog box, click Add. 
5 In the Select User, Computers, or Groups dialog box, in the Enter the object names 

to select box, type the account name on which you want your worker process to run 
(e.g. <Web domain>\user1), and then click OK. 

6 In the IIS_WPG Properties dialog box, click OK. 
7 Close the Computer Management screen. 

To change the identity for the NmConsole application pool on IIS6 
1 To change the account under which an application pool runs using IIS Manager 
2 In IIS Manager, expand the local computer, expand Application Pools, right-click the 

NmConsole application pool, and then click Properties. 
3 Click the Identity tab, and click Configurable. Configurable refers to registered user 

names. 
4 In the User name and Password boxes, type the user name and password of the 

domain account (e.g. user1).  
5 Click OK. 
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To change the identity for the NmConsole application pool on IIS7 
1 Open IIS Manager. (Control Panel > System and Security > Administrative Tools > 

Internet Information Services (IIS) Manager) 
2 In the Connections pane, expand the server node and click Application Pools. The 

Application Pools list populates. 
3 On the Application Pools page, select the NmConsole application pool, and then click 

Advanced Settings in the Actions pane. The Advanced Settings dialog appears. 
4 Select the Identity property under the Process Model heading, and then click the ... 

browse button. The Application Pool Identity dialog appears. 
5 Select Custom account and click Set. The Set Credentials dialog appears.  
6 Type the domain account name in the User name box (e.g. user1) 
7 Type and confirm the password for the domain account (e.g. user1) in the Password text 

box 
8 Click OK. The Set Credentials dialog closes. 
9 Click OK. The Application Pool Identity dialog closes. 
10 Click OK. The Advanced Settings dialog closes. 
11 Exit the IIS Manager application. 

To configure the account used for Anonymous authentication on IIS 6.0: 
1 In IIS Manager, expand the local computer, right-click the WhatsUpGold website, and 

then click Properties. THe WhatsUpGold Properties dialog appears. 
2 Click the Directory Security tab. 
3 In the Authentication and access control section, click Edit. The Authentication Methods 

dialog appears. 
4 Select the Enable anonymous access check box. 
5 Type the valid Windows user account you want to use for Anonymous access, or click 

Browse to locate it. 
6 Click OK. The Authentication Methods dialog closes. 
7 Click OK. THe WhatsUpGold Properties dialog closes. 
8 Exit the IIS Manager application. 

To configure the account used for Anonymous authentication on IIS 7.0: 
1 Open IIS Manager (Control Panel > System and Security > Administrative Tools > 

Internet Information Services (IIS) Manager).  
2 Click the Features View tab, double-click Authentication. The Authentication page 

appears. 
3 On the Authentication page, select Anonymous Authentication. 
4 In the Actions pane, click Edit. The Edit Anonymous Authentication Credentials dialog 

appears. 
5 Select Specific user, then click Set. The Set Credentials dialog appears. 
6 Type a user name and password for the identity. 
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7 Click OK. The Set Credentials dialog closes. 

 Important: If you use the Network Service account, you grant anonymous users all the 
internal network access associated with that account. 

8 Click OK to close the Edit Anonymous Authentication Credentials dialog box. 
9 Exit the IIS Manager application. 

Configure the Ipswitch Service Control Manager service to run under 
the domain user 
To configure services on the WhatsUp Gold server: 
1 Log in to the WhatsUp Gold server as user1. 
2 Click Start and type services.msc. Press Enter. The Services dialog appears. 
3 Locate Ipswitch Service Control Manager in the Name column and right-click it. 
4 Select Properties from the list. The Properties dialog for the service appears. 
5 Click the Log On tab. 
6 Select This account. 
7 Type or browse for user1. Enter and confirm the password for the user1 account. 
8 Click OK. 
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Finding more information 

Following are information resources for WhatsUp Gold. This information may be periodically 
updated and available on the WhatsUp Gold web site 
(http://www.whatsupgold.com/support/index.aspx). 

 Release Notes. The release notes provide an overview of changes, known issues, and 
bug fixes for the current release. The notes also contain instructions for installing, 
upgrading, and configuring WhatsUp Gold. The release notes are available at Start > 
Programs > Ipswitch WhatsUp Gold > Release Notes or on the WhatsUp Gold web 
site (http://www.whatsupgold.com/WUG15relnotes). 

 Application Help for the console and web interface. The console and web help 
contain dialog assistance, general configuration information, and how-to's that 
explain how to use the features. The Table of Contents is organized by functional 
area, and can be accessed from the main menu or by clicking Help in the console, or 
the ? icon in the web interface. 

 Additional WhatsUp Gold resources. For a listing of current and previous guides 
and help available for WhatsUp Gold products, see the WhatsUp Gold web site 
(http://www.whatsupgold.com/support/guides.aspx). 

 WhatsUp Gold optional plug-ins. You can extend the core features of WhatsUp 
Gold by installing plug-ins. For information on available plug-ins and to see release 
notes for each plug-in, see WhatsUp Gold plug-ins documentation 
(http://www.whatsupgold.com/support/guides.aspx). 

 Licensing Information. Licensing and support information is available on the 
MyIpswitch licensing portal (http://www.myipswitch.com/). The web portal provides 
enhanced web-based capabilities to view and manage Ipswitch product licenses. 

 Technical Support. Use the WhatsUp Gold Support Site for a variety of WhatsUp 
Gold product help resources. From here you can view product documentation, search 
Knowledge Base articles, access the community site for help from other users, and get 
other Technical Support information. The Support Site is available on the WhatsUp 
Gold web site (http://www.whatsupgold.com/support/index.aspx). 

 

http://www.whatsupgold.com/support/index.aspx
http://www.whatsupgold.com/WUG15relnotes
http://www.whatsupgold.com/support/guides.aspx
http://www.whatsupgold.com/support/guides.aspx
http://www.myipswitch.com/
http://www.whatsupgold.com/support/index.aspx
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Copyright notice 

©1991-2011 Ipswitch, Inc. All rights reserved. 

This document, as well as the software described in it, is furnished under license and may be 
used or copied only in accordance with the terms of such license. Except as permitted by 
such license, no part of this publication may be reproduced, photocopied, stored on a 
retrieval system, or transmitted, in any form or by any means, electronic, mechanical, 
recording, or otherwise, without the expressed prior written consent of Ipswitch, Inc. 

The content of this document is furnished for informational use only, is subject to change 
without notice, and should not be construed as a commitment by Ipswitch, Inc. While every 
effort has been made to assure the accuracy of the information contained herein, Ipswitch, 
Inc. assumes no responsibility for errors or omissions. Ipswitch, Inc., also assumes no liability 
for damages resulting from the use of the information contained in this document. 

IMail, the IMail logo, WhatsUp, the WhatsUp Gold logo, WS_FTP, the WS_FTP logos, Ipswitch, 
and the Ipswitch logo are trademarks of Ipswitch, Inc. Other products and their brands or 
company names, are or may be trademarks or registered trademarks, and are the property of 
their respective companies. 

 

This document was published on Wednesday, December 21, 2011 at 16:33. 
 


	System Requirements
	Operating system and virtual environment requirements
	Database requirements
	Web server requirements
	Framework and accessibility requirements
	Web and mobile interface requirements
	WhatsVirtual supported virtual environments
	Flow Monitor software requirements
	Hardware requirements and recommendations

	Installing WhatsUp Gold using WhatsUp Setup
	Before installing WhatsUp Gold
	Running WhatsUp Setup
	Installing WhatsUp Gold
	Installing WhatsUp Gold using advanced options
	Prerequisites for using an existing Microsoft SQL Server 2005, Microsoft SQL Server 2008 or 2008 R2, or Microsoft SQL Server Cluster 2005, 2008, or 2008 R2


	Activating WhatsUp Gold for new or upgraded licenses
	Upgrading WhatsUp Gold
	Updating user accounts after upgrade

	Repairing WhatsUp Gold
	Uninstalling WhatsUp Gold
	About device count limits
	About the Task Tray and Desktop Actions applications
	WhatsUp Gold Icons

	Installing IIS on Windows Server 2003
	Using Windows Authentication for remote database access
	Prerequisites
	Overview
	Creating and adding the domain user to the WhatsUp Gold and Microsoft SQL Server host machines
	Adding the domain user as a Microsoft SQL Server database user
	Installing WhatsUp Gold and configuring the connection to the remote database
	Set up the ODBC connection on the machine hosting WhatsUp Gold
	Configure WhatsUp Gold to use Windows Authentication
	Configure IIS on the machine hosting WhatsUp Gold
	Configure the Ipswitch Service Control Manager service to run under the domain user

	Finding more information
	Copyright notice

